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プロジェクトの開き方 

MayaUnityWebinar2013Proj フォルダが Unity

のプロジェクトです。File > Open Project...でこ

のフォルダを開いてプロジェクトをセットして下

さい。全てのスクリプトはプロジェクト内の

Assets > Game > Scripts に入っています。説明

の中で C#(.cs)ファイルの名前が出てきます。それ

らは Scripts フォルダに入っていますので、必要

に応じて参照して下さい。 

 

 

 

ゲームシーンを開く 

プロジェクトの設定が出来たら次にゲームのシーンを開きましょう。Assets > Game > Scenes > 

Level01.unityというシーンファイルを開いて下さい。本ゲームはこのシーンでできています。 

 

シーン内の箱や壁を自由に配置してステージを好みに変えてゲームを楽しんでみて下さい。他のプロジ

ェクトで作られたアセットをインポートしてシーンに配置すればゲームに組み込めますし、自分で作っ

たオブジェクトに置き換えれば見た目の全く違う、別のゲームにすることもできます。アセットを入れ

替えて、パラメーターを調整して、ゲームの反応を見て楽しんでいるうちに自然と Unity の使い方にも

慣れていくことでしょう。 

 

このドキュメントではカメラやプレイヤーと言ったゲームで不可欠な各要素の概要を説明しています。

読み進めればシーンがどんな風に作られているかわかってくることでしょう。慣れてきたらコードを開

いて見ましょう。プロジェクトに含まれているコードは全て C#で用意されています。複雑な処理をさせ
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るよりは、シンプルにゲームの流れを把握出来るように書かれていますので、編集も簡単に行えます。

コードを変更してゲーム内での反応を見つつ、独自のゲームに進化させてみて下さい。 

 

 

プレイの仕方 

 

 

プレイヤーキャラを操作して敵を倒したり敵から逃げたりしながら、最終エリアにいるボスを倒すこと

が本ゲームのゴールです。ボスを倒すと画面に「YOU WIN!」と表示されます。敵の体当たりを食らう

と左上のライフゲージが減っていきます。ライフがなくなるとゲームオーバーとなり、スタート地点に

戻されます。 

 

プレイヤーの操作は、キーボード入力、ゲームパッド入力、タッチ入力（モバイルもしくはマウスクリ

ック）に対応しています。 

 

キーボード入力 

移動：WASDキーおよび矢印キー 

ショット：左 Ctrlキー 

ジャンプ：スペースキー 

 

ゲームパッド入力 

移動：十字キーもしくはアナログスティック 

ショット：ボタン１ 

ジャンプ：ボタン２ 

（どのボタンをショット・ジャンプにするかはシーン内の Playerオブジェクトの Locomotion Ctrlコン

ポーネントで定義しています） 
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タッチ入力 

移動：バーチャルスティック 

ショット：右赤ボタン 

ジャンプ：左赤ボタン 

（各GUIはシーン内のGUICamera > virtualStick1, 2, 3のVirtual Stick Ctrlコンポーネントで制御し

ています） 

 

 

 

カメラの設定 

ゲーム制作にはカメラ制御が不可欠です。良いカメ

ラならユーザーはゲームに没頭できますが、カメラ

が変な動きをしているとゲームに集中できずにイラ

イラしてしまいます。 

 

ゲームのタイプによって適切なカメラというものが

あります。本ゲームでは横スクロールから始まり、

次に奥方向への移動もできるレベル構成（ステージ

構成）になっていますので、以下の様な特徴を持つカメラにしてあります。 

・ プレイヤーの少し前方を見せる 

・ プレイヤーの高さに応じてカメラの高さも変える 

・ プレイヤーとカメラの間に余計なオブジェクトがある場合、カメラがめり込まないようにする 

 

横スクロールアクションを作るなら今のカメラ設定のままで十分です。好みに応じて若干オプションを

調整してみて下さい。キャラクターの後ろにカメラが付くサードパーソンビューやカメラ自身がキャラ

の代わりになるファーストパーソンビューにも対応出来ます。以下のようにパラメーターを設定してみ

て下さい。 

 

シーン内のMain Cameraの Camera Ctrlコンポーネントの値を以下のように変えます。 
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横スクロールカメラ（デフォルト） 

Look Player Forward = ON 

Offset Player Forward = ON 

Look Forward Distance = 2 

Rotate Offset = 0, 0, 0 

Rotate Offset By Input = OFF 

Rotate Offset Input Sensitivity = 0.5 

Behind Target = OFF 

Height Movement = ON 

Target = Player>Sven>CameraTarget 

Distance = 8 

Height = 1 

Around Offset = 0 

Move Damping = 3 

Consider Collision = ON 

 

 

 

 

TPS風カメラ 

Look Player Forward = ON 

Offset Player Forward = OFF 

Look Forward Distance = 2 

Rotate Offset = 0, 0, 0 

Rotate Offset By Input = OFF 

Rotate Offset Input Sensitivity = 0.5 

Behind Target = OFF 

Height Movement = ON 

Target = Player>Sven>CameraTarget 

Distance = 5 

Height = 3 

Around Offset = 70 

Move Damping = 3 

Consider Collision = ON 
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FPS風カメラ 

Look Player Forward = ON 

Offset Player Forward = OFF 

Look Forward Distance = 2 

Rotate Offset = -10, 0, 0 

Rotate Offset By Input = ON 

Rotate Offset Input Sensitivity = 0.5 

Behind Target = ON 

Height Movement = ON 

Target = Player>Sven>CameraTarget 

Distance = -0.15 

Height = 0.55 

Around Offset = 0 

Move Damping = 60 

Consider Collision = OFF 

 

 

FPS 視点の場合はプレイヤーモデルがカメラに写り込まないようにするために Player > Sven > 

Mesh__M__Root > body_GEOの Skinned Mesh Rendererのチェックを外します。プレイヤーの動きが

カメラの動きに連動しますのでPlayerのLocomotion CtrlのDirection Is Chara Spaceをオンにします。

これで入力した方向とカメラ、プレイヤーの方向が一致するようになります。 

 

詳しいカメラの処理は CameraCtrl.cs を参照して下さい。このスクリプトをベースに作りたいゲームに

合ったカメラになるよう余分なコードを削除したり改造してみて下さい。別のプロジェクトにカメラを

移行するのなら、CameraCtrl.cs をコピーして持って行き、シーン内のカメラに追加するだけでできま

す。 
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プレイヤーの動き 

シーン内の Playerオブジェクトがプレイヤーです。ユーザーの入力に対する反応は Locomotion Ctrlコ

ンポーネントで行なっています。アニメーションと衝突判定は Player > Svenオブジェクトの Animator

と Character Controlerで行われています。 

 

Unity ではプレイヤーを動かすのに様々なアプローチがあります。従来のアニメーションシステムを使

用することもできますし、Unity4 から搭載された Mecanim でアニメーションさせることもできます。

本ゲームではMecanimを使用しています。 

 

従来通りの方法でプレイヤーを移動させる場合、ユーザーの入力に応じてプログラムで Transform を更

新して移動します。一方Mecanimを使用する場合は、アニメーションの中でキャラクターが移動してい

れば、自動的に Transformに値が設定されます。本ゲームでのプレイヤーは移動とジャンプをMecanim

に任せているので、移動速度、ジャンプ距離・高さを変更するには元の FBXファイルのモーションを変

更する必要があります。 

 

プレイヤーの回転の制御はMecanimでの処理と、従来通りのプログラムによる方向制御の両方を実装し

ています。それぞれで入力に対する反応の感触が異なりますので、作りたいゲームに合わせて選んでみ

て下さい。Playerオブジェクトの Locomotion Ctrlコンポーネントの Rotate By Mecanimのチェックを

変えて変更できます。Mecanimを使用するとリアリティのあるモーション補間がされます。従来通りの

方法なら、入力に対して瞬間的に反応させることができます。 

 

ユーザーの入力はワールド座標の方向です。ADキー（もしくは左右）なら X軸方向に、WSキー（もし

くは上下）なら Z軸方向に動きます。Locomotion Ctrlコンポーネントの Direction Is Chara Spaceを

オンにすると入力はキャラの方向になります。左右なら左右に、上下なら前後に動くようになります。

FTPゲームでは通常この操作でプレイヤーを動かします。 
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詳しくは LocomotionCtrl.cs を参照して下さい。 

 

 

敵の動き 

本ゲームでは minion という敵キャラがいます（プレハブ

はプロジェクト内の  Assets > Game > Models > 

minion_wip > Prefabs > minion です）。このモデルの色や

大きさを変えて一般兵、ちょっと強いやつ、ボス、という

三種類の敵を用意しています。どれも Enemy Locomotion 

Ctrlコンポーネントを使っており、パラメーターを調整す

ることで攻撃にバリエーションをつけています。 

 

敵ごとにバラバラのAIを作るのではなくパラメーター調整で違いを出すといろいろな恩恵を得られます。

プログラムが楽になったり、バグも少なくなるだけでなく、敵の動きのパターンに一貫性が出て、ユー

ザーにとっても理解しやすい、徐々に慣れて攻略しやすいものになります。敵ごとに動きが異なるとパ

ターンを読み取ることが難しくなり、とても難しいゲームになります。同じような動きをするけれど、

強い敵は動きが機敏になる、もしくはある部分に隙ができて倒しやすくなるという調整をする方が遊び

やすくなり、またゲームが進んでいる感も出てきます。 

 

Enemy Locomotion Ctrlコンポーネントの値を変更し

て AI の強さを制御できます。本ゲーム用での AI はと

てもシンプルです。敵は常に自分の中心から Player 

Search Area 分離れた範囲にプレイヤーがいないかチ

ェックしています。このサーチエリア内にプレイヤー

が入ってきたら Look Player Speedのスピードでプレ

イヤーの方向を向きます。Angle To Attackで指定した

範囲内にプレイヤーを捉えたら、体当たり攻撃を始め

ます。プレイヤーが敵の正面から逃げ出せば敵はプレ

イヤーを見失い、攻撃を止めます。 

 

敵はダメージを食らうと Damage Wait の分だけ放心

します。その隙にプレイヤーは攻撃したり逃げ出した

りできます。 

 

Random Walk をオンにすれば敵は適当に歩きまわり

ます。もし止まっていれば、歩く方向と時間を決めて

歩き始めます。また止まれば、また歩く方向と時間を
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ランダムに決めます。移動アニメーションはMecanimで行われます。回転の制御は Enemy Locomotion

が回転値を Transform に直に設定しています。回転の速度が難易度に関わってくるので、モーションで

修正するよりはパラメーターで簡単に制御できる方が調整しやすいからです。 

 

詳しくは EnemyLocomotionCtrl.csを参照して下さい。 

 

 

ダメージの処理 

ダメージの与え方は攻撃方法やプレイヤー、エネミーによって異なるように思えますが、基本的なやり

取りは同じでシンプルです。「HPを保持するコンポーネント」「HPを削るコンポーネント」という二つ

のやり取りで成り立っています。HPが減った時にHPが 0になったかを確認し、ダメージモーションを

再生するか、死亡とするか決めます。ダメージを与えるものが弾だったり体当たりだったりボムだった

りするので、ダメージを与える側にはいくつかのパターンがあります。 

 

HP を保持するコンポーネントとして、本ゲームでは HPCtrlBase.cs というスクリプトを用意していま

す。HP 管理の基本となるスクリプトです。このスクリプトの派生として EnemyHPCtrl.cs と

PlayerHPCtrl.csがあります。それぞれ敵とプレイヤーの HPコントロールをします。敵は単にダメージ

を受けるだけで良いのですが、プレイヤーはダメージを受けた後一定時間無敵になったり、ライフゲー

ジと連携させる必要があります。 

 

HPを削るコンポーネントには BulletCtrl.csと EnemyBodyAttackCtrl.csがあります。BulletCtrl.csは

プレイヤーが撃つ弾の制御を行います。プロジェクト内の Assets > Game > Effects > Prefabs > Bullet

プレハブでこのコンポーネントを使用しています。Playerオブジェクトの Locomotion Ctrlコンポーネ

ントがユーザーのボタン入力を確認し、弾を発射することになったら Shot Ctrlコンポーネントを実行し

ます。すると Bullet プレハブがシーン内にインスタンスされ、指定された速度で飛び出していきます。

Target Layerに指定されたレイヤーのオブジェクトのコライダーと衝突すると、衝突相手のHPコンポ
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ーネントを見つけて、ダメージ分 HPを減らします。 

 

EnemyBodyAttackCtrl.cs は敵に設定してあり、ぶつかった相手がプレイヤーなら HP コンポーネント

を見つけてダメージを与えます。 

 

おまけで EasterEggBomb.cs というスクリプトが用意してあります。キーボードで「unitea」と入力す

ると発動し、プレイヤーの距離から一定距離内の敵を見つけ出し、HPコンポーネントを取得して大ダメ

ージを与えます。 

 

このように攻撃方法が違っても、攻撃対象を見つけて、そのオブジェクトの HP コンポーネントを見つ

けてダメージをセットするというのは、どのゲームでも使える基本的なテクニックです。 

 

 

 

衝突判定 

いわゆる「あたり判定」「コリジョン判定」とい

われるものです。Unityではオブジェクトにコラ

イダーを設定すれば、自動で衝突を検知してくれ

ます。各オブジェクト、例えば壁の一枚一枚にコ

ライダーを用意することもできますが、今回は大

きな Box Collider をステージ内の各場所に配置

しています。処理負荷を減らすとともに、コリジ

ョン抜けといわれる、キャラクターがコライダーの隙間を抜けてしまうことを避けるためにもこのシー

ンでは効果的です。 

 

BackGround > CollisionGrp 内にシーンで使っているコライダーが含まれています。もちろん場合によ

っては個別のオブジェクトにもコライダーが含まれています。シーンを編集するのに壁をコピーしても

コライダーが含まれていませんので、必要に応じてコライダーを追加してください。 

 

コライダーの大きさは対象物よりちょっと大きめにしておくのがポイントです。特に敵のコライダーが

敵のモデルのサイズと同一だと、思った以上に弾が当たりません。ちょっと大きめにしておいたほうが

ゲームしやすくなります。 
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ゲーム全体の処理 

これまで説明してきたゲームの要素は、各オブジェクトで独立して動いているものです。カメラはカメ

ラだけで完結して勝手に動いていますし、プレイヤーも敵も独立して勝手に動いています。 

 

しかしゲームではシーン全体をチェックしてゲームの進行を管理するまとめ役が必要です。シーン内の

GameManagerオブジェクトに付いている Game Managerコンポーネントがその役割を担っています。 

 

Game Managerコンポーネントは、ライフゲー

ジとボスのチェックを行なっています。ライフ

ゲージがなくなれば、コンポーネントに登録し

てある「GAME OVER」の文字を表示し、ボス

が死んでいれば「YOU WIN!」の文字を表示し

てゲームを再スタートします。 

 

更にこのオブジェクトではシーン全体に関わる

機能を追加しています。Runtime Settingsコン

ポーネントは、ゲームスタート時に Ambient 

Light を設定します。ライティングをベイクす

る時とゲーム実行時でAmbient Lightの明るさ

を変えたいのでこの処理を加えています。もし他にもゲームスタート時に設定したいことがあれば、こ

のスクリプトを拡張すると便利です。 

 

Easter Egg Bombコンポーネントはいわゆる「バグ

技」です。「unitea」とキーボードで入力すると、プ

レイヤーからRange範囲内の敵に 10000のダメージ

を与えます。つまり、敵を一掃します。 

 

必要に応じてシーン全体に関わるコンポーネントを

このオブジェクトをまとめておくと便利です。 
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エフェクト処理 

ゲーム実行中に様々なコンポーネントが、様々なタイミングでエフェクトをインスタンスします。シー

ン内にどんなエフェクトがあって、どれを削除するべきかなど管理するのは大変です。大抵のエフェク

トは一定の時間表示したら不要になります。不要かどうかは、各エフェクトが管理するようにすれば漏

れ無くエフェクトを管理出来ます。 

 

全てのエフェクトはプロジェクト内の Assets > Game > Effects > Prefabs 内に入っています。Bullet

以外のエフェクトには全て Self Destroyコンポーネントが設定されています。Lifespanで指定した秒数

が経つと自身を削除します。Bulletは BulletCtrl.cs内で自滅するようにしてあります。これなら確実に

無駄なエフェクトが残らないようにできます。 

 

 

GUI 

本ゲームは簡単なアクションゲームで

すので凝った GUI は必要ありません。

シーン内の GUICamera オブジェクト

が GUI 表示用のカメラです。全ての

GUI 関係のオブジェクトはこのカメラ

の子供にして管理しています。 

 

カメラを GUI用にするにはカメラのパラメーターを調整します。Clear Flagsを Depth onlyに、Depth

を 1 にして、通常のビューの後に追加で描画されるようにします。Culling Mask を設定して、必要な

GUI素材だけが描画されるようにします。Projectionを Orthographicにしてパースがかからないように

し、GUIが歪まないようにします。より複雑な GUIを用意する時もこういった専用カメラを利用すると

便利です。 
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カメラの自動切り替え 

市販のゲームで遊んでいるとステージ進行に応

じて遊びやすいようにカメラの位置が変わりま

す。本ゲームでもゲームを進めていくと、所々

でカメラの高さが変わります。シーン内の

CameraEditAreas オブジェクトの子供のオブ

ジェクトでこの制御を行なっています。 

 

各オブジェクトには Camera Edit Area Status

コンポーネントがついています。同オブジェク

トに付いている Box Collider内にプレイヤーが入ってきたら、メインカメラの Camera Ctrlコンポーネ

ントにアクセスして値を変えます。HPの操作に似ています。 

 

カメラがエリア内に来たら何かを実行する、というスクリプトですのでこれを調整することで 

・カメラのアニメーションを再生してカットシーン演出を流す。 

・別のレベルに移動する。 

など様々なことに応用出来ます。 

 

 

ライティング 

本ゲームでは Unity 無料版を想定して制作されています。シーン内に Lights_PC、Light_iOS という名

前のオブジェクトがあり、使用している全てのライトが含まれています。それぞれ PC 用と iOS 用のラ
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イトです。 

 

Lights_○○ > EnvLightsにはシーン全体に影響を与えるライトが入っています。KeyLightを太陽光と

しています。これが基本的な明るさ、光の方向、影の方向を決め、シーンの印象を決定づけます。これ

をベースに空をシミュレートする SkyReflectionLightという Directional Lightが複数あります。地面の

照り返しは GroundReflectionLight で行なっています。KeyLight はリアルタイム描画にも使用します。

ベイクの時だけ明るさを更に調整するために KeyLight_bakeというライトを用意しています。ライトマ

ップのベイクにはEdit  > RenderSettingsのAmbient Lightの明るさも影響しますので注意して下さい。 

 

Lights_○○ > Area○にはエリアごとの独自のライティングが設定されています。全体のライティング

の傾向を決めた上で、細かいライトの調整を行なっています。 

 

Lights_○○ > EnvLights > HideWhenRun 内にあるオブジェクトはライトマップに影を落とすための

オブジェクトで、ゲーム実行時には Culling Ctrlコンポーネントによって非表示にされます。KeyLight

で大まかなライティングの方向性を決めた上で、このように影の落ち方を調整します。ライティングの

美しさは明るい所ではなく、むしろ影に現れますのでこのように影用オブジェクトを追加して、ステー

ジが魅力的になるよう調整していきます。影が沢山落ちていると、実際にはシーン内にそれほどオブジ

ェクトがなくても沢山あるように感じますので、モバイル向けのゲームでシーンの密度を演出するのに

も都合が良いです。 

 

今回のシーンでは iOS でベイクしたライトマップの明るさや傾向が PC と異なるので、Lights_PC と

Lights_iOSの二つで別管理にしてあります。Lights_PC と比べて Light_iOS内のライトは全て明るさが

半分以下になっています。ライトの数などは同じです。iOS ではカスタムのシェーダーを使用し、ライ

トマップを明るく描画するようにしています。PCと iOSで以下の対応が必要です。 

 

PC環境 

・ Lights_PCをアクティブに、Lights_iOSを非アクティブにします。 

・ ライトマップをベイクし直します。 

・ Projectウインドウで「l:UnlitBright」と入力してマテリアルを検索します。 

・ 見つかったマテリアルのシェーダーを Mobile/Unlit Bright(Supports Lightmap)から Bumped 

Specularに変更します。 

・ Projectウインドウで「l:UnlitNormal」と入力してマテリアルを検索します。 

・ 見つかったマテリアルのシェーダーをMobile/Unlit(Supports Lightmap)から Bumped Specularに

変更します。 
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iOS環境 

・ Lights_PCを非アクティブに、Lights_iOSをアクティブにします。 

・ ライトマップをベイクし直します。 

・ Projectウインドウで「l:UnlitBright」と入力してマテリアルを検索します。 

・ 見つかったマテリアルのシェーダーを Bumped Specular から Mobile/Unlit Bright(Supports 

Lightmap)に変更します。 

・ Projectウインドウで「l:UnlitNormal」と入力してマテリアルを検索します。 

・ 見つかったマテリアルのシェーダーを Bumped SpecularからMobile/Unlit(Supports Lightmap)に

変更します。 

 

 

 

パフォーマンス 

沢山のオブジェクトを出して、リッチなシェーダーを使って、大きなテクスチャを用意して、なるだけ

見た目をキレイにしたいところですが無限に描画できるわけではありません。特にモバイル向けのゲー

ムではパフォーマンスが処理落ちに影響をあたえるだけでなく、消費電力にも影響を与えますのでバッ

テリーの持ちや本体の発熱にも関わってきます。 

 

処理のパフォーマンスを良くするには、少ないオブジ

ェクト、簡易なシェーダー、小さなテクスチャを使う

ことが重要です。本ゲームではパフォーマンス調整の

ひとつのサンプルとしてカリング処理を提供していま

す。 

 

シーン内の敵モデルをまとめている Enemies > Area2, 

3, 4, 5に Culling Ctrlコンポーネントがついています。

このコンポーネントはカメラかプレイヤーの距離が
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Culling Distance よりも外である場合は子のオブジェクトを非表示にします。プレイヤーが進んでいく

ごとに必要な分だけ敵を表示することで、処理負荷を軽減しています。 

 

 

ビルド 

File > Build Settings...でターゲットになるプラットフォームを選択してビルドします。PCやWeb用な

らそのままビルドします。iOS 向けの場合は「ライティング」項目に書かれている iOS 環境用のライテ

ィング、シェーダー設定を行った後にビルドします。 

 

iPhone などに出力する場合は XCode のインストール、アップルのサイトでのデベロッパー登録など必

要になりますので、Unityのドキュメントを参考にして下さい。 
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